
 

 

  آموزشگاه پارسی ماد 01و  01بین کوچه -روبروی دادگستری شهید قدوسی-آدرس: خیابان توحید

            www.parsimad.com                      @AFP Tohidآدرس سایت:                     83318881تلفن:

پارسی ماد حرفه ایفنی  آموزشگاه  
 ICDLمجموعه سوالات تستی کاربر

 

 به کلیه برنامه ها و دستورالعمل هایی که برای ارتباط با رایانه و استفاده از آن به کار می رود .......... می گویند. (0

 د( پردازش اطلاعات  ج(سخت افزار  ب( میان افزار   افزارالف( نرم 

 

 طبقه بندی نرم افزار ها عبارت است از : (1

 د( همه موارد صحیح است ج( پردازشگر لغات ، صفحه گسترده  ب( سطح بالا، سطح پایین الف( سیستمی ، کاربردی

 

 کدام بخش است؟به حافظه اصلی جزء وظایف باز کردن برنامه از روی حافظه ی جانبی  (8

 د( مترجم ها ج( برنامه های کمکی  ب( سیستم عامل ها  الف( برنامه های کاربردی

 

 نرم افزاری که مدیریت منابع متصل به کامپیوتر را به عهده داشته و رابط انسان با سخت افزار می باشد چه نام دارد؟ (8

  د( سیستم عامل ها و مفسر هاج( مترجم   ب( زبان های برنامه نویسی الف( نرم افزار های کمکی

 

 کدام یک از گزینه های زیر در مورد سیستم عامل صحیح نیست؟ (5

 الف( سیستم عامل به عنوان یک رابط بین سخت افزار، کاربر و همچنین برنامه های کاربردی عمل می کند.

 ب( سیستم عامل اداره کننده ی تمام قسمت های رایانه است.

 افزار رایانه را به کار می گیرد.ج( نرم افزاری که سخت 

 د( تعداد سیستم عامل ها از تعداد نرم افزار های کاربردی بیش تر است.

 

 برای تبدیل دستورات غیر قابل فهم به زبان قابل درک کامپیوتر کدام برنامه وظیفه ی این کار را دارد؟ (6

 د( مترجم ها  دیج( نرم افزار های کاربر  ب( نرم افزار های کمکی  الف( سیستم عامل

 

 جزء کدام گروه از برنامه ها هستند؟ Word , Powerpoint , Excel , Accessبرنامه هایی نظیر  (7

  )برنامه های کاربردی کوچک(Utilityب(     الف( سیستم عامل

  د( برنامه های آموزشی   ج( برنامه های کاربردی
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 امور زیر استفاده می شود؟( در کدام یک از Powerpointنرم افزار ارائه مطالب) (3

 د( ذخیره اطلاعات  ج( تایپ نامه ب( نمایش مطالب و نوشته ها الف( امور حسابداری

 

 کدام نرم افزار جزء نرم افزار های سیستمی به شمار می رود؟ (9

 Adobe Photoshopب(    Microsoft Wordالف( 

 Microsoft Internet Explorerد(    Microsoft Windows XPج( 

 

 کدامیک از سیستم عامل های  زیر چند کاربره نمی باشد؟ (01

 Docد(   Winxpج(   Linuxب(   Unixالف( 

 

 سیستم عامل روی کدامیک از ابزار های ذخیره سازی زیر نصب می شود؟ (00

 Romد(   Rom-CDج(   Ramب(   Hard Diskالف( 

 

 ( نیست؟GUIکدام یک از سیستم عامل های زیر دارای رابط گرافیکی ) (01

 Linuxد(   Dosج(   Windows 2000ب(   Windows Xpالف( 

 

 چند کاربره است؟ Dosسیستم عامل  (08

 د( چند کاربره  ج( سه کاربره  ب( دو کاربره   الف( تک کاربره

 

 برای تایپ متن یا ویرایش آن از نرم افزار های ................. استفاده می شود. (08

 د( واژه پرداز  ج( صفحات گسترده نویسیب( زبان برنامه  الف( مدیریت پایگاه

 

 کدام یک از موارد زیر نرم افزار کاربردی است ؟ (05

 Microsoft Windows 7ب(    Microsoft Windows Vistaالف( 

 Microsoft Windows XPد(     Microsoft Powerpoinج( 

 

 واحد مناسب عملیات ریاضی و منطقی نامیده می شود؟ CPUکدامیک از بخش های  (06

 Romد(   Registerج( ثبات یا   ALUب(   CUالف( 
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 کدامیک از حافظه ها ، حافظه اصلی محسوب می شوند؟ (07

 د( هیچکدام Floppy Diskج(   Hard Diskب(  ROM,RAMالف( 

 

 نمی باشد ؟  CPUکدامیک از بخش های زیر جزء واحد های  (03

 ROMد(   Registerج( ثبات یا   CUب(   ALUالف( 

 

 موارد زیر جزء حافظه های جانبی )ثانویه ( نیست ؟کدامیک از  (09

 Ramد(   Tapeج(   ROM-DVDب(  ROM-CDالف( 

 

 تکنولوژی ساخت کدام حافظه زیر الکترونیکی است ؟  (11

 د( موارد ب و ج هر دو صحیح است DVDج(   CDب(   Memory Cardالف( 

 

 کدام یک جزء بد افزار ها محسوب می شوند ؟ (10

 د( همه موارد  ج( تروجان ها   ب( کرم ها   الف( ویروس ها 

 

 کدام مورد بیانگر احتمال ویروسی شدن سیستم و برنامه های سیستم رایانه ای است ؟ (11

 ب( خراب شدن و کارنکردن بعضی برنامه ها   الف( پایین آمدن سرعت عملکرد سیستم

 د( همه ی موارد  ج( خوب کار نکردن یا حذف بعضی از اطلاعات

 

 ه برای جلوگیری از سرایت ویروس به سیستم رایانه ای چیست ؟ بهترین را (18

 الف( بررسی نامه های الکترونیکی دارای فایل های الصاقی

 ب( داشتن یک برنامه ضد ویروس که توانایی به روز شدن را داشته باشد

 ج( به کارگیری یک برنامه ی ضد ویروس در سیستم

 و غیره USBو  CDد( استفاده از حافظه های جانبی مثل 

 

 ویروس های رایانه به چه روش هایی وارد رایانه می شوند ؟  (18

  و شبکه و اینترنت USBو  CDد(   و شبکه USBو   CDج(   CD , USBب(  CDالف( 
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 به نرم افزاری که مصرف کننده برای مدت مشخصی به طور آزمایشی از آن استفاده می کند و بعد از مدتی غیر قابل (15

 استفاده می شود نرم افزار ............ می گویند . 

 Open Sourceد(  Share Wareج(   Demoب(   Free wareالف( 

 

 نرم افزاری .............. نرم افزار هایی هستند که به صورت رایگان توزیع و کد منبع آن به همراه نرم افزار ارائه می شود؟ (16

 Open Sourceد(   WareShareج(  Demoب(  Free wareالف( 

 

 نادرست است ؟  Sleepکدامیک از گزینه های زیر درباره  (17

 الف( با کلیک بر روی این گزینه کامپیوتر در حالت آماده باش قرار می گیرد .

 ب( در این حالت مصرف انرژی برق کاهش می یابد . 

 می گردد .ج( در این حالت با زدن کلید یا حرکت ماوس کامپیوتر به حالت عادی بر 

 د( در این حالت ما مجبور به راه اندازی سیستم ویندوز هستیم و زمان زیادی مصرف می گردد .

 

 از کدام روش استفاده می کنیم ؟ Folder optionجهت فعال نمودن  (13

  اقدام می نمائیم . Start|Control panel|Folder Optionالف( از مسیر 

 در هر پنجره ای Toolsب( استفاده از منوی 

 Desktopج( با استفاده از کلیک راست ماوس بر روی 

 File Optionد( 

 

 ( به چه معناست ؟Folderپوشه ) (19

 همان فایل است .الف( 

 ب( محلی برای نگهداری و سازماندهی فایل ها و برنامه ها

 ج( آیکنی برای دسترسی سریع تر راحت تر به برنامه ها

 سخت د( آیکنی برای نمایش دیسک

 

 ( به چه معناست ؟ Fileفایل ) (81

  لاعات موجود در رایانه می گویندالف( به همه اط

 ب( محلی برای نگهداری و سازماندهی فایل ها و برنامه ها

 د( آیکنی برای نمایش دیسک سخت   آیکنی برای دسترسی سریع تر راحت تر به برنامه ها ج(
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 کدام گزینه برای انتخاب آیتم های همجوار استفاده می شود ؟  (80

 Shiftد(   Homeج(    Ctrlب(    Altالف( 

 

 برنامه های در حال اجرا بر روی چه ناحیه ای قرار دارند ؟  (81

 Gadgetsد(   Startج(   Menuب(    Task barالف( 

 

 با ترکیب کدام کلید ها می توان محتوای یک پوشه را انتخاب کرد ؟  (88

 Alt+aد(   Ctrl+Aج(   Shift+Aب(    Alt+Cالف( 

 

88) ISP  چیست ؟ 

 الف( شرکت های ارائه خدمات اینترنتی

 ب( مرورگر وب را می گویند . 

 می گویند . ISPج( فرم های اشتراک در اینترنت را 

 طریق خط تلفن می گویند .د( به اتصال اینترنت از 

 

 صفحه خانگی یک وب سایت را ............. می گویند . (85

 Current pageد(   Web pageج(  Home pageب(  First Pageالف( 

 

 دریافت اطلاعات از اینترنت را ................ می گویند . (86

 Moveد(  Downloadج(  Uploadب(   Loadالف( 

 

 آدرس صندوق پستی صحیح می باشد ؟ کدام یک از گزینه های یک (87

 bayat@Irantvto.irالف( 

 Yahoo.com@infoب(

 www.yahoo.comج( 

  yahoo@com.alirezaد(

 

 پیغام های ناخواسته در صندوق پستی به چه نامی مشهورند ؟ (83

 د( ایمیل  Virusج(   Spamب(   Noiseالف( 

 

mailto:bayat@Irantvto.ir
mailto:Yahoo.com@info
http://www.yahoo.com/
mailto:yahoo@com.alireza
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 کدام پوشه در بر گیرنده پیام های دریافت شده می باشد ؟ (89

 Sent Itemد(  Outboxج(   Draftب(    Inboxالف( 

 

 چه می گویند ؟ به آدرس منحصر به فرد یک صفحه وب در اینترنت (81

 ISPد(    URLج(    Siteب(    Domainالف( 

 

 با کدام برنامه زیر می توان بدون اتصال به اینترنت نامه های خود را در آن نوشت ؟ (80

 د( الف و ب هر دو   Outlook Expressج(   Googleب(   Yahooالف( 

 

 کدام دکمه زیر فهرستی از ساخت هایی که اخیرا مشاهده کرده ایم را نمایش می دهد ؟  (81

 Historyد(   Forwardج(   Favoritesب(   Homeالف( 

 

 اگر بخواهیم رونوشتی از نامه خود را به اشخاص دیگری ارسال کنیم آن را در کادر متنی ........... می نویسیم ؟ (88

 د( هیچکدام  Subjectج(    CCب(   TOالف( 

 

یا مرورگر اینترنت را با یک صفحه خالی نشان  IE، ، با انتخاب کدام یک از گزینه های زیر  Internet Optionدر پنجره  (88

 خواهد داد ؟ 

 Clear Historyد(  Use Defaultج(   Use Blankب(    Use Currentالف( 

 

 کدام یک از دامنه های زیر نظامی بودن سایت را نشان می دهد ؟  (85

 NETد(  ORGج(   MILب(   EDUالف( 

 

 برای مرتب سازی صعودی از کدام گزینه استفاده می شود ؟  (86

 Date modifiedد(  Typeج(  Descendingب(  Ascendingالف( 

 

 ................... استفاده کرد .برای انتخاب یک جمله باید از کلید ترکیبی  (87

 Ctrl+Altب(     Ctrl+Clickالف( 

 Viewد(    Ctrl+Homeج( 
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 برای وارد کردن یک فایل تصویری در محیط سند ، از کدام گزینه استفاده می کنیم ؟ (83

 Home / Pictureب(     Insert / Pictureالف( 

 Insert / Chartد(     View / Pictureج( 

 

 تقسیم یک خانه جدول به چند خانه از کدام گزینه استفاده می کنیم ؟برای  (89

 Split Tableب(     Merge Cellsالف( 

 Align Top Leftد(      Split Cellsج( 

 

 برای ایجاد تفاوت در سر صفحه و پاصفحه ی صفحات زوج و فرد از کدام گزینه استفاده می کنیم ؟ (51

 fferent Odd & Even pagesDiب(    Different first pageالف( 

 Insert Header and Footerد(     Even Pageج( 

 

 برای درج شماره صفحه به چه صورت باید عمل نمود ؟ (50

 Insert > Header & Footer > page Numberالف( 

 Home > Page Number ب(

 View > Page Numberج( 

 Page layout > Macros > Page Numberد( 

 

 میزان فرورفتگی از کدام گزینه استفاده می شود ؟برای تنظیم  (51

 Hyphenateد(   Alignmentج(   Spacingب(   Indentالف( 

 

 برای جایگزینی عبارتی در اسناد از ................... استفاده می شود ؟ (58

 Searchد(  Selectج(   Findب(    Replaceالف( 

 

 بکار می رود ؟کدام مورد برای لغو آخرین عمل انجام شده  (58

 Ctrl+Vد(   Ctrl+Zج(   Ctrl+Xب(    Ctrl+Yالف( 

 

 حالت بزرگنمایی چه تاثیری بر سند می گذارد ؟ (55

 ب( سند را با بزرگ نمایی چاپ می کند    الف( سند را با بزرگ نمایی ذخیره می کند 

 کندد( سایز قلم متن را دست کاری می     ج( هیچ گونه تاثیری بر چگونگی چاپ ندارد
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 گزینه های مربوط به حاشیه بندی صفحه در کدام زبانه قرار دارند ؟ (56

 Homeد(   Viewج(   Page Layoutب(   Insertالف( 

 

 کدام گزینه برای تنظیم شروع شماره صفحات از عدد خاصی استفاده است ؟ (57

 Positionب(    Alignmentالف( 

 ntinueoCد(     Start atج( 

 

 از کدام کلید ترکیبی در صفحه کلید استاندارد استفاده می شود ؟برای تایپ نیم فاصله  (53

 Ctrl+Enterب(      arShift+Spacebالف( 

 Shift+enterد(      Alt+Spacebarج( 

 

 از کدام استفاده می شود ؟ Wordبرای تبدیل یک جدول به متن در  (59

 Table To Text > Tableالف( 

 Convert to Text > Tableب( 

 Text To Table > Tableج( 

 Table To Text > Convertد( 

 

 در هنگام ذخیره سند کدام فرمت به عنوان پسوند پیش فرض فایل انتخاب می گردد ؟ (61

 txtد(   docxج(   htmlب(    dotالف( 

 

 کدام گزینه برای تغییر نوع نمودار رسم شده در اسلاید است ؟ (60

 Data Lableب(    Chart Layoutالف( 

 Chart Typeد(    Chart Titleج( 

 

 با کدام روش می توان از الگوهای از قبل آماده شده برنامه نمایش ایجاد کرد ؟ (61

 From Design Templateب(    Blank Presentationالف( 

 New Presentationد(   From Auto Content Wizardج( 

 

 کردن اسلاید جدید بکار می رود ؟ کدام از گزینه های زیر برای اضافه (68

 Alt+Sد(   Ctrl+Iج(   Ctrl+Mب(    Ctrl+Nالف( 
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 گزینه را انتخاب می کنیم ؟ کدام Speed/Effectحرکت دادن متن صورت یکجا در قسمت برای  (68

 همه مواردد(   All at Onceج(   By wordب(  By letterالف( 

 

 در عمل انتقال اسلاید از محل اولیه ............ و در محل مکان نما قرار می گیرد . (65

 Deleteد(    Printج(    Cutب(   Copyالف( 

 

 انتخاب کدام گزینه اسلاید را به طور خود کار نمایش می دهند ؟ (66

 هیچکدامد(   Design Templateج(   Color Schemesب(  Auto Previewالف( 

 

 در کدام نما نمی توان متن یا تصویر به اسلاید اضافه نمود ؟ (67

 Outlineد(   Normalج(  lide SorterSب(   Note pageالف( 

 

 برای حذف اسلاید انتخاب شده : (63

 Delete Slideگزینه  Editب( از منوی    Delete Slideگزینه  Fileالف( از منوی 

 Delete Slideگزینه  Formatد( از منوی    Delete Slideگزینه  Viewاز منوی ج( 

 

 کدام گزینه را انتخاب می کنیم ؟  Insertبرای ایجاد یک نمودار سازمانی در اسلاید از سربرگ  (69

 Shapesد(   Smart Artج(   ganization ChartOrب(   Chartالف( 

 

 کدام گزینه برای استفاده از جلوه های آماده متحرک سازی است ؟ (71

 Slide Transitionد(   Slide showج(   Advanced Slideب(   Animateالف( 

 

 کدامیک از موارد زیر از توانایی های برنامه های صفحه گسترده نمی باشد ؟ (70

 ک برنامه اجرایی مستقل کامپیوتریالف( تولید ی

 ب( حسابداری یک شرکت بازرگانی

 ج( مدیریت اطلاعات و داده های تجاری

 د( بررسی میزان فروش یک شرکت 

 

 به هر سطر از جدول داخل کاربرگ اکسل ............ می گویند . (71

 Columnد(    Rowج(  Tableب(   Cellالف( 
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 . را می فشاریم Delete کلیدبرای حذف نمودار روی ........... کلیک کرده ،  (78

 د( راهنمای نمودار  ج( کل نمودار  ب( محور نمودار  الف( عنوان نمودار

 

 فرمان ......... کاربرگ فعال را حذف می کند ؟ (78

 Insertد(   Tabcolorج(   Deleteب(    Renameالف( 

 

 نام پیش فرض فایل های اکسل چیست ؟ (75

 Databaseد(   Workbookج(   Bookب(   Documentالف( 

 

 چه کاربردی دارد ؟ Numberدر کادر محاوره ای  Decimal Placesگزینه  (76

 ب( جداکردن ارقام اعداد به صورت سه تایی    نمایش اعداد منفی الف(

 د( تعیین نوع عدد     ج( تعداد ارقام اعشار

 

77) Chart Type در نمودار ها چه کاربردی دارد ؟ 

 ب( تعیین راهنمای نمودار    الف( تعیین عنوان نمودار

 د( تغییر نوع نمودار    ج( نمایش خطوط راهنما

 

 فایل های اکسس با چه قالبی ذخیره  می شوند ؟ (73

 PPTXد(   Accdbج(   BMPب(    DOCXالف( 

 

 جهت جمع آوری و سازماندهی اطلاعات در مورد یک موضوع از کدام نرم افزار استفاده می شود ؟ (79

 د( جدول  ج( برنامه نمایشی  ب( واژه پرداز  الف( بانک اطلاعاتی

 

 به مجموعه ای از یک یا چند رکورد ............ می گویند ؟ (31

 د( بانک اطلاعاتی  ج( فایل  ب( جدول  الف( فیلد

 

 کوچکترین جزء اطلاعاتی در پایگاه داده چه گفته می شود ؟ (30

 د( فیلد  ج( بانک اطلاعاتی  ب( رکورد  الف( جدول
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 کدام نوع داده زیر برای متن های طولانی استفاده می شود ؟ (31

 Currencyد(   Long Textج(   Numberب(   Textالف( 

 

 در پایگاه داده چه می گویند ؟ اطات بین جداولبه ارتب (38

 Databaseد(    Integrity Rulesج(   Entityب(   Relationshipالف( 

 

 به هنگام تعریف داده های عددی کدام نوع جهت عدد های اعشاری مناسب است ؟ (38

 Decimalد(   Long Integerج(   Integerب(    Byteالف( 

 

 کدام رابطه در بین جداول اشتباه است ؟ (35

 ب( رابطه یک به چند    الف( رابطه یک به یک 

 د( رابطه چند به چند   چند به یک ج( رابطه

 

 قرار می گیرد ؟  Byteحداکثر چه عددی در فیلد عددی از نوع  (36

 د( نامحدود    155 ج(  0118 ب(   65111 الف(

 

 نمی باشد ؟ Accessکدام گزینه از اجزای بانک اطلاعاتی  (37

 Databaseد(   Reportج(   Tableب(    Formالف( 

 

 برای اضافه کردن توضیحات به یک سلول از چه گزینه ای استفاده می کنیم ؟ (33

 Homeاز سربرگ  Editگزینه  الف(

 Reviewاز سربرگ  New Commentب( گزینه 

 Viewسربرگ   Insert Commentج( گزینه 

 Insertاز سربرگ  Commentد( سربرگ 

 

 کلیک های ........... مورد استفاده قرار می گیرند . Redoبرای اجرای سریع فرمان  (39

 Ctrl+Xد(   Ctrl+Vج(   Ctrl+Yب(   Ctrl+Zالف( 

 

 را انتخاب کنید Excel Template. گزینه ی است در لیست ......کاف Templateبرای ذخیره کردن یک الگو به عنوان  (91

 File Nameد(  Save as Nameج(  Save as Typeب(   Save Inالف( 


